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PART I. CPU/BACKPLANE
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1. INTRODUCTION

Chapter 1 introduces the Smart Star embedded control system
and describes the features associated with the backplane chassis
and the CPU Card. The Tool Kit containing the hardware essen-
tials to begin using the Smart Star is described, and the software
highlights are presented.

The Smart Star is a modular and expandable embedded control system whose configuration
of Digital 1/0, A/D Converter, D/A Converter, and Relay Cards can be tailored to a large
variety of demanding real-time control and data acquisition applications.

The typical Smart Star system consists of a rugged backplane with a built-in voltage regulator,
a CPU Card, and one or more 1/0O cards. The CPU Card plugs into a designated slot on the
backplane chassis, which has additional slots available for any combination of 1/0 cards.

A high-performance Rabbit 2000 microprocessor on the CPU Card operates at 22.1 MHz
to provide fast data processing.

1.1 Features

e C-programmable to create a custom user interface

o Flexible functionality—modular configuration allows interchanging or replacing indi-
vidual 1/0 cards

e Expandable—up to 168 1/O ports
e Choice of two backplanes—with either 3 or 7 slots for 1/O cards

e Choice of CPU cards—with or without one RJ-45 10/100-compatible Ethernet port
with 10Base-T Ethernet interface

e RS-232 and RS-485 serial ports allow networking to other Smart Star units, single-
board computers, or enterprise computing centers

e 128K SRAM and 512K flash memory, optional 512K SRAM
e Real-time clock

e Watchdog supervisor

e Backup battery

e Optional backlit 122 x 32 graphic display/keypad module

¢ RabbitLink Ethernet gateway available for remote download/debug, Web serving, and
e-mail
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Table 1 lists the backplanes, CPU cards, and the 1/O cards that are available for the Smart
Star control system. Appendix A provides detailed specifications for the Smart Star back-
planes and the CPU cards.

Table 1. Smart Star Backplanes and Cards

Card Model Features

7 1/0 card slots, 1 CPU card slot, header connections

SR9010 for optional LCD/keypad module
Backplane
SR9050 31/0O card slots, 1 CPU card slot, header connections
for optional LCD/keypad module
SR9150 Full-featured CPU card with RJ-45 Ethernet port
CPU
SR9160 Full-featured CPU card without RJ-45 Ethernet port
SR9200 16 digital inputs, 8 digital sinking outputs
SR9210 8 digital inputs, 16 digital sinking outputs
SR9220 8 digital inputs, 8 digital sinking outputs
Digital I/0

SR9205 16 digital inputs, 8 digital sourcing outputs

SR9215 8 digital inputs, 16 digital sourcing outputs

SR9225 8 digital inputs, 8 digital sourcing outputs

SR9300 12-bit A/D converter, 11 channels, 0 V — 10 V

A/D Converter SR9310 12-bit A/D converter, 11 channels, -10 V —+10 V

1/0 Cards

SR9320 12-bit A/D converter, 11 channels, 4 mA — 20 mA

SR9400 12-bit D/A converter, 8 channels, 0 V - 10 V

D/A Converter SR9410 12-bit D/A converter, 8 channels, -10 V —+10 V

SR9420 12-bit D/A converter, 8 channels, 4 mA — 20 mA

5 SPST relays and 1 SPDT relay, each protected

SR9500 with onboard snubbers

Relay

SR9510 8 SPDT relays (no snubbers)
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1.2 User Connections

Connections to the 1/O cards are made via a ribbon cable connector or optional field wir-
ing terminals that are either pluggable or have screw terminals. Three different Field Wir-
ing Terminals (FWTSs) are available. Table 2 lists the 1/O cards and the Rabbit part
numbers for the corresponding FWTs.

Table 2. Guide to FWT Selection

Rabbit Part Number
Pluggable Terminals Screw Terminals

FWT Description I/O Cards
Digital I/0

FWT27 Relay (SR9510) 101-0420 101-0514

A/D Converter
FWT18 DIA Converter 101-0421 101-0515
FWT18R Relay (SR9500) 101-0422 101-0516

NOTE: Appendix A, “Field Wiring Terminals,” provides further information on FWTs,
including their dimensions.

1.3 Optional Add-Ons
The LCD/keypad module is the only available optional add-on. Further details on the
LCD/keypad module are provided in Appendix B.

Visit our \Web site for up-to-date information about additional add-ons and features as
they become available. The Web site also has the latest revision of this user’s manual.
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1.4 Development and Evaluation Tools
1.4.1 Tool Kit

The Tool Kit has the hardware essentials that you need to create and use your own Smart
Star control system.

The items in the Tool Kit and their use are as follows:

e Smart Star (SR9000) Getting Started instructions.
e Dynamic C CD-ROM, with complete product documentation on disk.

e Programming cable, used to connect your PC serial port to the Smart Star CPU Card to
write and debug C programs that run on the Smart Star control system.

e FWT27 pluggable field wiring terminal.
e Screwdriver.

e DC power supply, used to power the backplane, which in turn supplies power to the
CPU card and the 1/O cards. The DC power supply accepts an AC input of 100 V to
240V atupto 0.6 A, and delivers a DC output up to 1.1 A at 24 V.

e Rabbit 2000 Processor Easy Reference poster.
e Registration card.

1.4.2 Software

The Smart Star control system is programmed using Rabbit’s Dynamic C. A compatible
version is included on the Tool Kit CD-ROM.

Rabbit also offers add-on Dynamic C modules containing the popular uC/OS-11 real-time
operating system, as well as PPP, Advanced Encryption Standard (AES), and other select
libraries. In addition to the Web-based technical support included at no extra charge, a
one-year telephone-based technical support module is also available for purchase. Visit
our Web site at www.rabbit.com or contact your Rabbit sales representative or authorized
distributor for further information.
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1.5 CE Compliance

Equipment is generally divided into two classes.

CLASS A CLASS B

Digital equipment meant for light industrial use Digital equipment meant for home use

Less restrictive emissions requirement:
less than 40 dB pV/mat 10 m
(40 dB relative to 1 uV/m) or 300 uV/m

More restrictive emissions requirement:
30 dB uV/mat 10 m or 100 uV/m

These limits apply over the range of 30-230 MHz. The limits are 7 dB higher for frequencies
above 230 MHz. Although the test range goes to 1 GHz, the emissions from Rabbit-based
systems at frequencies above 300 MHz are generally well below background noise levels.

The CPU card, 1/0 cards, and backplane in the Smart Star embedded control system have
been tested and were found to be in conformity with the following applicable immunity
and emission standards as described in Table 3.

Table 3. CE Compliance of Smart Star Backplanes and Cards

Used for CE
Card Model Description Compliance
Testing
7 1/O card slots, 1 CPU card slot,
SR9010 header connections for optional Full-featured X
LCD/keypad module*
Backplane
3 1/0 card slots, 1 CPU card slot,
SR9050 header connections for optional Sub-version
LCD/keypad module*
cpU SR9150 |22.1 MHz CPU card with Ethernet Full-featured X
SR9160 |22.1 MHz CPU card without Ethernet | Sub-version
SR9200 |16 inputs, 8 sinking outputs Full-featured X
. SR9205 |16 inputs, 8 sourcing outputs Full-featured X
Digital 1/0
SR9210 |8 inputs, 16 sinking outputs Sub-version
SR9220 |8 inputs, 8 sinking outputs Sub-version
(%)
E SR9300 | Eleven 12-bit analog inputs (0-10 V) | Sub-version
g A/D Converter | SR9310 |Eleven 12-bit analog inputs (£10 V) Full-featured X
SR9320 | Eleven 12-bit analog inputs (4-20 mA) | Sub-version
SR9500 5 SPST relays_ and 1 SPDT relay, each Full-featured »
protected with onboard snubbers
Relay
SR9510 |8 SPDT relays (no snubbers) Full-featured X

* No CE compliance testing was done with the LCD/keypad module connected to a Smart Star
embedded control system. A system consisting of Smart Star boards and an LCD/keypad mod-
ule therefore cannot be considered to be CE-compliant.
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The sub-versions of the boards are also CE-compliant. All boards that
are CE-compliant have the CE mark.

Several Smart Star boards are not yet CE-compliant. These boards are
listed in Table 4.

Table 4. Smart Star Backplanes and Cards Not CE-Compliant

Card Model Description Comments
Backplane SR9000 7 1/0 card slots, 1 CPU card slot | Legacy product
CPU SR9100 25.8 MHz CPU card Legacy product

SR9400 Eight analog outputs (0-10 V)

Passed emissions tests,

D/A Converter SR9410 Eight analog outputs (10 V) immunity tests pending

SR9420 Eight analog outputs (4-20 mA)

Immunity
The CE-compliant Smart Star boards meet the following EN55024/1998 immunity standards.
e EN61000-4-3 (Radiated Immunity)

e EN61000-4-4 (EFT)
e EN61000-4-6 (Conducted Immunity)

Additional shielding or filtering may be required for a heavy industrial environment.
Emissions

The CE-compliant Smart Star boards meet the following emission standards when used
with a Smart Star embedded control system that contains a Rev. C or higher version of the
Rabbit 2000 microprocessor with its spectrum spreader turned on and set to the normal
mode. This microprocessor is used in all Smart Star CPU boards that carry the CE mark.

e EN55022:1998 Class A
e FCC Part 15 Class A
NOTE: The Smart Star embedded control system satisfied the Class A limits but not the

Class B limits. Such equipment need not be restricted in its sale, but the following
warning must be included in the instructions for its use.

Warning
This is a class A product. In a domestic environment this product may cause radio inter-
ference, in which case the user may be required to take adequate measures.

Additional shielding or filtering may be needed to meet Class B emissions standards.
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1.5.1 Design Guidelines

Note the following requirements for incorporating a Smart Star embedded control system
into your application to comply with CE requirements.

General

e The power supply provided with the Tool Kit is for development purposes only. It is the
customer’s responsibility to provide a CE-compliant power supply for the end-product
application.

e When connecting the Smart Star embedded control system to outdoor cables, the cus-
tomer is responsible for providing CE-approved surge/lighting protection.

¢ Rabbit recommends placing digital I/O or analog cables that are 3 m or longer in a
metal conduit to assist in maintaining CE compliance and to conform to good cable
design practices.

e When installing or servicing the Smart Star embedded control system, it is the responsi-
bility of the end-user to use proper ESD precautions to prevent ESD damage to the
Smart Star.

Safety

e All inputs and outputs to and from the Smart Star embedded control system must not be
connected to voltages exceeding SELV levels (42.4 VV AC peak, or 60 VV DC).

e The lithium backup battery circuit on the CPU card in the Smart Star embedded control
system has been designed to protect the battery from hazardous conditions such as
reverse charging and excessive current flows. Do not disable the safety features of the
design.

1.5.2 Interfacing the Smart Star to Other Devices

Since Smart Star embedded control systems are designed to be connected to other devices,
good EMC practices should be followed to ensure compliance. CE compliance is ulti-
mately the responsibility of the integrator. Additional information, tips, and technical
assistance are available from your authorized Rabbit distributor, and are also available on
our Web site at www.rabbit.com.
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2. GETTING STARTED

Chapter 2 explains how to connect the power supply to the
Smart Star backplane, how to install the CPU Card on the back-
plane, and how to connect the programming cable to the CPU
Card. Once you run a sample program to demonstrate that you
have connected everything correctly, you will be ready to go on
to install 1/0 cards and finish developing your system.
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2.1 Attach the CPU Card to the Backplane

1. Orient the backplane with the PROCESSOR SLOT facing away from you as shown in
Figure 1.

Align facing edge of
CPU card with back
edge of alignment hole

Align facing edge of
CPU card with back
edge of alignment hole

Figure 1. Attach the CPU Card to the Backplane

2. Position the CPU Card above the backplane as shown in Figure 1.

3. Carefully insert the CPU Card header into the PROCESSOR SLOT on the backplane
and line up the facing edge of the CPU Card with the back edge of the alignment holes
on the backplane as shown in Figure 1.

NOTE: Be careful to line up the pins on the CPU Card with the socket on the backplane when
installing the CPU Card. The CPU Card can be damaged once power is applied if the CPU Card
is not installed correctly.

4. Use the two 4-40 screws supplied with the CPU Card to anchor the plastic brackets so
that they hold the CPU Card firmly in place on the backplane.
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2.2 Connect the Power Supply

Connect the power supply to the POWER IN
connector on the backplane—the red (posi-
tive) wire to +RAW and the black (negative)
wire to GND, as shown in Figure 2.
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Figure 2. Power Supply Connections

(North America)

A USER connection is supplied on the
backplane to allow an independent power
supply to be used for future development.
For now, use a wire jumper to connect
USER to +RAW so that they share the same
power supply.

NOTE: Be careful to hook up
the positive and negative leads
exactly as described. Only the
+5 V circuitry is protected
against reverse polarity.

Notice to Customers
Outside North America

The power supply included with the Smart Star
Tool Kit may be used worldwide. Customers
outside North America simply need to
exchange the line cord and plug from the
power supply to their wall outlet with one
available locally.

1. To exchange the line cord and plug, first
remove the existing line cord. To access the
screws, use a screwdriver to gently lift up
and remove the plastic insulating cover.

To
Smart Star To ?I/at”
POWER IN outie

=
(1.8 OO bdhdbd]

Plastic
Insulating j )
Cover

Figure 3. Power Supply Connections
(overseas)

2.Unscrew the wires at the ground, L, and N
terminals.

3.Attach the line cord that you obtained locally
to the power supply. Be sure to follow any
color-coding conventions, for example,
green/yellow to ground, brown to L, and
blue to N terminals.

4.Ensure that the wires are attached securely
and are not touching each other. Snap on
the plastic insulating cover.

NOTE: The power supply included
with the Smart Star Tool Kit is
intended for development purposes
only.
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2.3 Programming Cable Connections

1. Connect the programming cable to the CPU Card.

Connect the 10-pin PROG connector of the programming cable to header J2 on the CPU
Card as shown in Figure 4. Connect the other end of the programming cable to a COM
port on your PC. Note that COM1 on the PC is the default COM port in the Dynamic C
installation.

NOTE: Be sure to use the programming cable (Part No. 101-0513) supplied with the
Smart Star Tool Kit—the programming cable has red shrink wrap around the RS-232
converter section located in the middle of the cable. Programming cables from other
Rabbit kits are not designed to work with the Smart Star.

piAG[]| Diagnostic

connector

Red /
shrink wrap TO

PC COM port

Colored side
towards pin 1

rRod || Programming
connector

Figure 4. Programming Cable Connections

NOTE: Never disconnect the programming cable by pulling on the ribbon cable.
Carefully pull on the connector to remove it from the header.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use
an RS-232/USB converter (Part No. 20-151-0178) with the programming cable sup-
plied with the Tool Kit. Note that not all RS-232/USB converters work with Dynamic C.
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2. Apply power.
Plug the power supply in to a nearby outlet. The CPU Card is now ready to be used.

NOTE: A hardware RESET is accomplished by unplugging the power supply, then plug-
ging it back in.

To power down the SmartStar, unplug the power supply. You should disconnect power
before making any circuit adjustments or changing any connections to the SmartStar.
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2.4 Installing Dynamic C

If you have not yet installed Dynamic C version 7.06P3 (or a later version), do so now by
inserting the Dynamic C CD from the Smart Star Tool Kit in your PC’s CD-ROM drive.
The CD will auto-install unless you have disabled auto-install on your PC.

If the CD does not auto-install, click Start > Run from the Windows Start button and
browse for the setup . exe file on your CD drive. Click OK to begin the installation once
you have selected the setup . exe file.

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, create a new desktop icon that points to default.htm in the
docs folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.

The Dynamic C User’s Manual provides detailed instructions for the installation of
Dynamic C and any future upgrades.

NOTE: If you have an earlier version of Dynamic C already installed, the default instal-
lation of the later version will be in a different folder, and a separate icon will appear on
your desktop.
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2.5 Starting Dynamic C

Once the CPU Card is installed and connected as described above, start Dynamic C by
double-clicking on the Dynamic C icon or by double-clicking on decrab XXXX.exe in the
Dynamic C root directory, where XXXX are version-specific characters.

Dynamic C defaults to using the serial port on your PC that you specified during installa-
tion. If the port setting is correct, Dynamic C should detect the CPU Card and go through
a sequence of steps to cold-boot the CPU Card and to compile the BIOS. (Some versions
of Dynamic C will not do the initial BIOS compile and load until the first time you com-
pile a program.)

If you receive the message No Rabbit Processor Detected, the programming
cable may be connected to the wrong COM port, a connection may be faulty, or the target
system may not be powered up. First, check both ends of the programming cable to ensure
that it is firmly plugged into the PC and the programming port.

If there are no faults with the hardware, select a different COM port within Dynamic C.
From the Options menu, select Communications. Select another COM port from the list,
then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C
still reports it is unable to locate the target system, repeat the above steps until you locate the
active COM port. You should receive a Bios compiled successfully message
once this step is completed successfully.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load a sample program, it is possible that your
PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

e Locate the Serial Options dialog in the Dynamic C Options > Communications
menu. Choose a lower debug baud rate.
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2.6 PONG.C
You are now ready to test your set-up by running a sample program.

Find the file PONG. ¢, which is in the Dynamic C saMPLES folder. To run the program,
open it with the File menu (if it is not still open), compile it using the Compile menu, and
then run it by selecting Run in the Run menu. The STDIO window will open and will dis-
play a small square bouncing around in a box.

This program does not test the serial ports on the CPU Card, but does ensure that the CPU
is basically functional.
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2.7 Installing I/O Cards

1. Orient the backplane with the CPU Card already installed and facing towards you as
shown in Figure 5.

plastic brackets when you
install I/O cards starting
from the slot furthest away
from the CPU card. You
may have to remove the
CPU card to install the
brackets on the 1/O card

in SLOT 0.

J
Tip: It's easier to install the é

|

|

000000000000
00000000000(

Place tabs on

card into
alignment slot i
=

EOO EOOOO
000 00000

0000000000000 0000000000000
00000000000 0000O000OO000oN

Note: The plastic brackets
on the CPU card are
attached on the opposite

[ side of the board relative
to the I/O cards.
4 power supply

Figure 5. Installing I/O Cards on the Backplane

2. Position the new 1/0O card above the backplane over any unused slot position (SLOT 0 to
SLOT 6) as shown in Figure 5. Note the slot number and the type of 1/0O card since
Dynamic C addresses the 1/0O cards by slot number.

3. Carefully insert the 1/O card header into the slot on the backplane and line up the tabs
on the 1/0O cards with the slots on the backplane as shown in Figure 5.

4. Use the two 4-40 screws supplied with the 1/0 card to anchor the plastic brackets on the CPU
Card or the 1/0 card firmly on the backplane. Tighten the screws as needed using a Phillips
screwdriver whose shaft is at least 3" (7 cm) long, but is no thicker than 0.16" (4 mm).
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2.8 Where Do | Go From Here?

NOTE: If you purchased your Smart Star through a distributor or Rabbit partner, contact
the distributor or partner first for technical support.

If there are any problems at this point:

e Use the Dynamic C Help menu to get further assistance with Dynamic C.
e Check the Rabbit Technical Bulletin Board at www.rabbit.com/support/bb/.
e Use the Technical Support e-mail form at www.rabbit.com/support/.

If the sample program ran fine, you are now ready to go on to install 1/O cards, explore
other Smart Star features, and develop your own applications.

Chapter 3, “Hardware Features,” provides detailed information about the CPU Card, and
how to install the 1/O cards. Be sure to take the total current consumption of the individual
cards into account when selecting a power supply. Appendix C.1, “Current Require-
ments,” provides more detailed information. Chapter 4, “Software,” describes the
Dynamic C software libraries and introduces some sample programs for use with the CPU
Card. Chapter 6, “Smart Star Specifications,” provides specifications for the backplanes
and the CPU cards, including mounting and clearance recommendations.

Separate sections in this manual have been prepared for the various 1/0O cards, and include
complete information about their pinouts and Dynamic C software libraries, including
sample programs.

Once you have developed your application and bench-tested the finished system, you may
install the finished system.
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3. HARDWARE FEATURES

Chapter 3 describes the principal features for the Smart Star
backplanes and CPU cards.

» Power Distribution
- Power Distribution
- 1/O Card Slots

» Smart Star CPU Card Features
- Serial Communication
- Memory
- Other Connectors
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3.1 Backplane Features
3.1.1 Power Distribution

Power is supplied to the Smart Star control system from an external source through header
J1 on the backplane. The +5 V circuitry on the Smart Star control system is protected
against reverse polarity by a Schottky diode as shown in Figure 6.

+V_USER

" +RAW SWITCHING VOLTAGE +5V
— I REGULATOR I
L
=0 .
o

I *

Figure 6. Smart Star Control System Power Supply Schematic

A capacitor provides surge current protection for the voltage regulator, and allows the
external power supply to be located some distance away from the Smart Star control sys-
tem. A switching power regulator is used. The +RAW input voltage may range from 9 V to
30V (15 V to 30 V you plan to use a D/A Converter Card).

The backplane has inputs for two separate power supplies on header J1, +RAW and
V_USER. The +RAW power supply goes to the switching power regulator, which outputs
the +5 V DC used by the CPU Card and by the 1/O cards plugged into the backplane. The

V_USER connection allows a different voltage to be available on the 1/O cards for future
development.

NOTE: Always connect V_USER to +RAW with a jumper wire between terminals 1 and 2
on header J1 for the development activities described in the Smart Star manuals.
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Figure 7 shows how the power supplies are distributed on the backplane and on the CPU Card.

(b) CPU Card

Power In SLOTO0...6
24V DC power +RAW +*RAW | +5 V switching | +5V 20 ]
supply included 9-30 VDC regulator

in Tool Kit . —
= Jumper
, +V_USER
poney supply | VUSER oo -
(for future use) 9-30VDC — -lfl_
i (a) Backplane i
PROCESSOR
SLOT
[ 1. +5V Backup Battery
|J_:|M le/s 3V DC
CPU logic, ’/RAM
2 +V_USER memory SRAM. CPU,
RTC
51 +RAW
1,26, 52

Figure 7. Smart Star Power Supplies—Backplane and CPU Card
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Figure 8 shows how the power supplies are distributed on the 1/0 cards.

+5V
+RAW
+V_USER )
K
Multiplexer/Latch = — Relay Coils
High-Voltage Outputs = = Multiplexer/Latch
(user-selectable)
Digital I/0 Relay
Multiplexer/Latch = = Multiplexer/Latch
Voltage Regulators/ = = \/oltage Regulators:
A/D Reference Voltage 12V
A/D Converter D/A Converter

Figure 8. Smart Star Power Distribution on I/O Cards

NOTE: Note that Rabbit recommends tying +RAW to +V_USER as explained in
Section 2.2, “Connect the Power Supply.”

The user has the option of using a separate power supply to K when configuring the high-
power outputs for the digital 1/0 cards. The connection to K is through the user interface
on the digital 1/O card. Further details are provided in Chapter 7, “Digital 1/0 Cards.”
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3.1.2 1/O Card Slots

The backplane serves to make the CPU Card accessible to up to seven 1/O cards plugged

in to SLOT 0 through SLOT 6 on the backplane. Figure 9 shows the pinout for SLOT 0

through SLOT 6 (headers J3-J9) on the backplane.

J3-J9
GND [ {m o 1DO
D1 []o o[ D2
D3 []o o[ D4
D5 ]o o[ D6
D7 [|o o[ A0
A1 [o o[ JA2
A3 []o o[J/IORD
NIOWR [| o © [ /SELECT
INHIB_OUT [] o o [J /ATTNA
/RESET (|0 o[ J+5V
NC []° o[ +V_USER
T™X C]o o [JRX
SCLK | © [ GND

Figure 9. Pinout for SLOT 0 Through SLOT 6
(Headers J3-J9) on the Backplane

NOTE: The SR9050 backplane can accommodate up to three I/O cards plugged in to
sLoT o through sLoT 2 (headers J3-J5).
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3.2 Smart Star CPU Card Features
3.2.1 Serial Communication

The CPU Card has one screw terminal header for RS-232/RS-485 serial communication
(J3) and one RJ-45 Ethernet jack (J7, SR9150 only). The RJ-12 jack, J6, is reserved for
future use and therefore has no signals. The pinouts are shown in Figure 10.

Mode 0: Mode 1: Mode 2:
RS-485/3-wire RS-232 two 3-wire RS-232 one 5-wire RS-232

J3 J3 J3
82
RE g8 sER2R gHEZR
SISISNIEINZ SO606800 SO60600
7 6 5 4 3 2 1 7 6 5 4 3 2 1 7 6 5 4 3 21

J3 J6 J7
SISISINEINZ)

Figure 10. Smart Star CPU Card Serial Pinout

The factory default for the CPU Card is one RS-232 (3-wire) and one RS-485 serial chan-
nel, corresponding to Mode 0 in Figure 10. The other modes shown in Figure 10 are set in
software via the Dynamic C serMode function call (see Section 4.5, “Serial Communica-
tion Calls™).

3.2.1.1 RS-232

The CPU Card’s RS-232 serial channel is connected to an RS-232 transceiver. The trans-
ceiver provides the voltage output, slew rate, and input voltage immunity required to meet
the RS-232 serial communication protocol. Basically, the chip translates the Rabbit 2000°s
0 V to +Vcc signals to RS-232 signal levels. Note that the polarity is reversed in an
RS-232 circuit so that +5 V is output as approximately -10 V and 0 V is output as approx-
imately +10 V. The transceiver also provides the proper line loading for reliable communi-
cation.

The maximum baud rate is 115,200 bps. RS-232 can be used effectively at this baud rate
for distances up to 15 m.

The Rabbit 2000 serial port C TXD and RXD signals are presented either as RS-232 TX
and RX or as RTS/CTS handshaking, depending on the mode selected with the Dynamic C
function serMode. The RS-232 signals are available on screw terminal header J3.
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3.2.1.2 RS-485

The CPU Card has one RS-485 serial channel, which is connected to the Rabbit 2000
serial port C through an RS-485 transceiver. The chip’s slew rate limiters provide for a
maximum baud rate of 250,000 bps, and allows networking over a distance of up to 300 m
(or 1000 ft.). The half-duplex communication uses the Rabbit 2000’s PD4 pin to control
the data enable on the communication line.

The RS-485 signals are available on the CPU Card through screw terminal header J3.

The Smart Star control system can be used in an RS-485 multidrop network. Connect the
485+ to 485+ and 485- to 485— using single twisted-pair wires on the CPU Card’s header
J4 as shown in Figure 11. Note that a common ground is recommended.

Ground recommended

Figure 11. Multidrop Smart Star Network
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The CPU Card comes with a 220 Q termination resistor and 681 Q bias resistors already
installed and enabled with jumpers across pins 1-2 and 5-6 on header JP1, as shown in

Figure 12.

Factory
Default

& S
O sl
|I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I |I
POPPRRRE PR IRrr PR

Figure 12. RS-485 Termination and Bias Resistors

For best performance, the bias and termination resistors in a multidrop network should
only be enabled on both end nodes of the network. Disable the termination and bias resis-
tors on any intervening Smart Star units in the network by removing both jumpers from

header JP1.

TIP: Save the jumpers for possible future use by “parking” them across pins 1-3 and 4-6
of header JP1. Pins 3 and 4 are not otherwise connected to the CPU Card.
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3.2.1.3 Programming Port

The CPU Card has a 10-pin programming header labeled J2. The programming port uses
the Rabbit 2000’s Serial Port A for communication. Dynamic C uses the programming
port to download and debug programs.

The programming port is also used for the following operations.

e Cold-boot the Rabbit 2000 on the RabbitCore module after a reset.

¢ Remotely download and debug a program over an Ethernet connection using the
RabbitLink EG2110.

e Fast copy designated portions of flash memory from one Rabbit-based board (the
master) to another (the slave) using the Rabbit Cloning Board.

Alternate Uses of the Serial Programming Port

All three clocked Serial Port A signals are available as
e asynchronous serial port
e an asynchronous serial port, with the clock 